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INTRODUCTION

Collaborative Programming Project concern to implementation of a tool as an Eclipse plugin. It aim
is to support the work in a distributed environment and running the project according to Scrum

methodology.

MOTIVATION

In the present situation, working in distributed team on one project occurs very often. Therefore,
there is a considerable need to support communication between team members and improve the
work in a distributed environment.

Proposed tool aims to support the following aspects of running a project according to Scrum

methodology with the distributed character of working team.

e Execute Daily Scrum Meeting in distributed environment. (Stand-up)

e Planning and task complexity estimating support. (Sprint Planning Meeting)

e Communication support in distributed environment through the integrated tools in
Eclipse IDE (Small Team)

e Collaboration support between team members by preview code changes in real time.

e Performing and managing peers’ code review with proper components support.

PROJECT CONTENT

Project was running by students team at Wroclaw University of Technology, lead by PhD, DSc Lech
Madeyski (e-mail: mailto:lech.madeyski@pwr.wroc.pl, WWW: http://madeyski.e-informatyka.pl).

Team members:

e inz. Krzysztof Rodak (mailto:164825@student.pwr.wroc.pl)
e inz Przemystaw Skawinski, (mailto:164534@student.pwr.wroc.pl)
e inz. Adam Strojek, (mailto:164707 @student.pwr.wroc.pl)
e inz. Jakub Zawada, (mailto:164820@student.pwr.wroc.pl)

Project Source Code:

e Sourceforge Project Site: https://sourceforge.net/projects/collabprogram

e Academic GIT Repository
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Plugin dependencies:

e XStream Library ( http://xstream.codehaus.org/ )

e http://www.java2s.com/Code/Jar/DEF/com.ibm.icu 3.6.1.v20070417.jar.htm

e Graphical Modeling Framework (GMF) Runtime1.5.0
org.eclipse.gmf.feature.group

e Graphical Modeling Framework (GMF) Runtime Examples 1.5.0
org.eclipse.gmf.examples.runtime.feature.group

e Smack API ( http://www.igniterealtime.org/projects/smack/index.jsp )

Used methodology:

SCRUM with tool: http://www.assembla.com
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FUNCTIONALITY

CODE REVIEW

Code review is a systematic examination of application source code. Its purpose it to easily locate
and fix mistakes during development phase, which effects in improved both overall quality of
software and developer’s skills.

CP Plugin supports code review practice as a peer review in distributed environment. It enables

following actions for user, who take a role of peers’ code reviewer:

1. Add code review/ general comment - this functionally allows user to perform peer code
review and present it to rest of the team in form of synchronized data with enough details
to cover most of use cases.

Edition of above parameter is available by following interface:

{j"_ Problems | Bl Console | 4@ Task Editor | Stackoverflow quickview | ] Stackoverflow | & Review Editor 23 L|:,_| =8
Reviewer: jzawada Related file: | CmdParserPlayerToken
Review type: |Program logic = Severity: Critical -
Summary: Connection validation
Details for review: 3

Before performing any network activity, connection validation should be performed.
Please respond to issue ASAP.

Description of code review details information:
o Review type - reviewer / commenter can choose from following types: Program
logic, Refactory need, Comment, Test summary.
o Severity - inform on how urgent and important is message. Options: Minor,
Normal, Critical.
o Summary - Short information, which summaries issue.

o Details - which should contains details about specific code review / comment



o Related file (optional) - code review mechanism gives a possibility for reviewer to
buf.append(”(init ™);

select file or even specific file’s [@ 32

lines, which are a topic for

current review - this way it’s

buf.append(teamilame) ;

aw

easy to see which review refers to which file and piece of code in the project, for all

peers.

o Reviewer - automatically, reviewer information is added to review data

2. Maintain existing code review, comments, navigate to related files * 'EE" ==

All code review data is presented using ergonomic table-based interfaces. It enables basic

operation like adding, editing, deleting code reviews.

& Contacts (" Tasks (" Reviews &2

#® DailyScrum Lisﬂ

-

D Severity Type

1 Refactory ..  Mormal
2 Comment Minor
3 Unset Unset

4 Program lo.. Miner
5 Test summ... Critical

Rewviewer
k.rodak
jzawada
jzawada
k.rodak

j.zawada

Summary

Meed to refactor

Just comment

Wrong access
Test is not passing

File

CmdParserPlayerToke...
CmdParserPlayerToke...
CmdParserPlayerToke...
CmdParserPlayerToke...

Errors.java

Review Description

Please refactor this part

Make sure that ...

Moreover, selecting code review, automatically triggers opening related file and moving cursor

to related piece of code - which enhances usability and make it easy to track important data.




6 Unset Unset jzawada Errors.java
| 7 Refactory need  Miner jzawada Refactor StringB... CommandFacteryjava  Maybe we should chan... | (1) Select code review

“II Errors.java “II CmdParserPlayerTokenManager.java J 5
20 (2) Related file is opened and related piece of code is lightened.
el = f**
31 * This is used to initialise a player.
32 * [@param teamName The team the player belongs to.
33 * [param isGoalie If the player is a ggglie. MNote: Only one go:
34 * f@param wersion
35 *f
382 @Suppresskarnings{"unchecked™)
37 public wvoid addPlayerInitCommand(String teamMame, boolean isGoal

StringBuffer buf = new StringBuffer

38

e buf.append("({init "};

48 buf.append(teamName} ;

41 buf.append("” (wversicn

42 if (is@oalie) {

43 if ("".equals(versicn)) {

a A ..l e B [ [ gy (I (R p—




MANAGING TASKS

Task managing feature helps developer team in keeping good work organization. Task feature is
one of the fundamental part in almost each application/plugin of this kind. There is possibility to

create new tasks, remove or edit existing tasks. Each task consists of the following fields:

Id - unique identity number
Name - short task name

Description - description of the task, information about what is to do;

o O O O

CurrentStatus - information about the task state, it can be one of:
=  NEW -just created task without owner
= ASSIGNED - task with assigned owner
= READY_FOR_TESTS - task ready for tests
= TESTED - task tested
=  RESOLVED - resolved
o Creation - date of creation
o Deadline - deadline
o Complexity - workload, evaluated with Scrum Poker

o currentOwner - team member who is responsible for the task

& Contacts | @ Tasks &3 & Reviews | @ DailyScrum List % o m T O

g Mame Description Status Creation Deadline Complexity




=1 Problems (E Console (’ Task Editor 22 [ Stackoverflow quichriew 8 Staclcoverﬂofww # Review Editoq =B

&
D 1 |
MName new
Description description
Status MNEW -
Creation 2012-01-11 %
Deadline m

Complexity 0.0

Current COwner unset -

Poker:

w& Reuiewﬂ @ DailyScrum Lisﬂ @ 5 = =0

= Problems (E Console (‘ Task Editor 22

1

ng

Mame

new

Description

description

Status Creation Deadline Complexity

NEW

11Jan 201213:.. 1lJan201213:.. 0.0

£ stackoverflow quichriew | Stackoverﬂoﬂ @ Review Editcﬂ

=0

=l

D [1

Name new
Description description
Status MNEW
Creation 2012-01-11 %
Deadline m

Complexity 0.0

Current Owner unset

Poker




SUPPORTING SCRUM PRACTICES

When considering team working in distributed environment, basic data synchronization is not
enough to minimize differences comparing to stable, one-location environment. Therefore, we
introduce mechanisms, which support various SCRUM-related practices in distributed

environment.

SCRUM DAILY MEETINGS

Collaborative Programming plugin supports Daily Scrum practice in distributed environment. It
provides a tool to making Daily Scrum Reports. It can replace Standups, when team is distributed.

On each day, each team member should first make a report and answers three questions:

o What has he done during the last day?
o Whatis he going to do today?

e Any questions or problems?

All report can be found on Daily Scrum Report List view, as a list of reports, with them creation date

and author.
| ® Contacts | @ Tasks | @ Reviews | & DailyScrum List &3 # ¢ =0
D Date . Author
8 9 Jan 2012 22:58:46 GMT a.strojek@pwr-agile.strojek.info
4 9 Jan 2012 22:58:46 GMT j.zawada@pwr-agile.strojek.info
3 9 Jan 2012 22:58:46 GMT p.skawinski@pwr-agile.strojek.info
6 9 Jan 2012 22:50:03 GMT k.rodak@pwr-agile.strojek.info
9 8 Jan 2012 22:58:46 GMT j-zawada@pwr-agile.strojek.info
5 8 Jan 2012 22:58:46 GMT a.strojek@pwr-agile.strojek.info
7 8 Jan 2012 22:50:16 GMT p.skawinski@pwr-agile.strojek.info
1 8 Jan 2012 22:50:03 GMT k.rodak@pwr-agile.strojek.info
2 7 Jan 2012 22:50:10 GMT p.skawinski@pwr-agile.strojek.info

View provides easy way to sort reports with id, date, or author.

To manage reports list are used 3 buttons:

e add new daily Scrum report
o edit selected daily Scrum report
e remove selected daily Scrum report

To use edit or remove element, some report on list have to be selected.

7

v

# ¢ = TOBc &|§/ = T 0| B Console 2 @ =" O B Console 2\ @ Task!
[ Add New Daily Scrum Rf Edit Selected Dnal”},. Scrunlw p;p;,.i [ Remove Selected Daily Scrum Report },5
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After selecting Add New Daily Scrum Reportor Edit Selected Daily Scrum Report we are

presented with a pop-up window which allows to add / edit proper information concerning

daily scrum report. Moreover, we can set exact date for SCRUM report.

18 Pack R\ Jumit| = O

What I've done during the last day:

RS | = Daily Scrum Metting Report - L=aa=l
i RoboCup Author: p.skawinski@pwr-agile.strojek.info ‘
Date: 2012-01-07 %]

Yesterday, I worked on the class.

What I'm going to do today:

Twill contin_ue with the cléss.

MY questions, problems or needs:

No blocking issuesJ

| ® Contacts | Tasks| @ Reviews ],’. DailyScrum List £ g =0
) Date < Author
1 8 Jan 2012 22:50:03 GMT krodak@pwr-agile.strojek.info
2 7 Jan 2012 22:50:10 GMT p.skawinski@pwr-agile.strojek.info
3 9 Jan 2012 22:58:46 GMT p.skawinski@pwr-agile.strojek.info
4 9 Jan 2012 22:58:46 GMT jzawada@pwr-agile strojek.info
5 8 Jan 2012 22:58:46 GMT a.strojek@pwr-agile.strojek.info
6 9 Jan 2012 22:50:03 GMT krodak@pwr-agile.strojek.info
7 8 Jan 2012 22:50:16 GMT p.skawinski@pwr-agile.strojek.info
8 9 Jan 2012 22:58:46 GMT a.strojek@pwr-agile strojek.info
9 8 Jan 2012 22:58:46 GMT jzawada@pwr-agile.strojek.info
10 10 Jan 2012 23:20:47 GMT p.skawinski@pwr-agile.strojek.info

|| & Console

No consoles
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SCRUM POKER

Estimation of tasks’” workload is one of the crucial issue in efficient development. Having well
estimated tasks allows for good tasks allocation. The plugin supports well known practice - Scrum
Poker. The practice involves all team members to carry some kind of voting in order to evaluate
tasks workload. Each user has at his disposal 8 cards with different values. The user choose the
card, which value reflects the workload the most properly in his opinion. Choices of other users are
visible after the choice of the user. When all votes are made, the users can discuss the results and

put numerical value for task complexity according to chosen card and suggestions.
: T WU W =
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k.rodak a.strojek p.skawinski j-zawada

0] 4 ] [ Cancel
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WHITEBOARD

Whiteboard is a tool that allow to write text or/and draw diagrams, and share them with team.

Whiteboard can be started with top menu action: Collaboration Programming ->Whiteboard.

o-Edlipse Platform = .y

Collaboration Programming | Wir

7% Whiteboard 0
o B8
It start as a editor, with shape palette, and properties view.
'@ “Whiteboard.geo 53 _ =a)
uvlﬂ'Z DEREY TN SR SOOI OIS - RN IR (] 12 14 16 0 18 . 200 22 24 26 28 30 +32¢ 34 ceeneen 36 40 42 o440 45 Palette b
: ‘meas-
: © Geometric Sh... #
: © Oval
: 3 Cylinder
- _iRectangle
5 Types
3 & Rectangle
& Shadow
E Rectangle
: @ 3D Rectangle
- & Rounded
: Rectangle
~ % Polygon #»
2 A Triangle
: @ Hexagon
z @ Octagon
: @ Pentagon
2 % Diamond
5 / Line
| Propeties 2 ®~ =0
]
“Appearance  Fonts and Colors:
Rulers&Grid | || o
Advanced
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Palette includes 3 groups of shapes: Geometric shapes, Rectangle types and Polygons

text tool.

With the properties view we can change a lot of element properties and styles:

. It has also line, note and

[ E Properties 2

iz
| ——]

A & Fonts and Colors:

Advanced ‘Tahoma Y |9 e ‘

Routing
Styles:
@ Oblique

Lines and Arrows:

-
EEE

Smoothness:
@ None () Norm

© More

) Less

ump links
Status:
@ Nene () All

) Below () Above

Reverse jump links

) Rectilinear Tree

|| Avoid obstructions Closest distance

Type:
© Semi-Circle ©) Square
() Chamfered

=
A = Property Value
Advanced |4 View
Bold % false
Description U= Student
Fill Color LI (255,255,203)
Font Color M (0,0,0)
Font Height Gig
Font Name = Segoe Ul
Gradient =
Ttalic % false
1> Layout Constraint ¢
Line Color L1 (255,204,102)
Line Width =51
Rounded Corners Radius o
Strike Through % false
4 Styles
Line Type = Solid
Text Alignment U= Left
Transparency o
Underline % false
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[ ) Note
= Text

|

& m

Note Attachment

i & Rectangle
Types

ld Rectangle

lad Shadow
Rectangle

& 3D Rectangle

&J Rounded
Rectangle

~ % Polygon
A Triangle
(W Hexagon
) Octagon
@ Pentagon
< Diamond
/ Line
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Class diagram

Example usage of whiteboard:
Student is alsc a

person, dont forget

L]
)
\
\
\
\
\
\
\
\
1 Person
\
)
\ > | A
\
\
\
1
(]
Student Professor
' [ ' 8 ' 10 ' 12 ' 14 ' 16 ' 18 ' 20 ' 22 ' 24 26 ' 28 ' 30 ' 32 ' 34 ' 36 ' 38 ' 40
N
: Text
-+
: Text Text Text
true false
) r
' i
: ?
: Text 1
2 Texdt Text
: T
: Add » SRS IR
2 Navigate » |
- File » | [Z] SaveAsImageFile... -
g Edit »| & Print.. 1o
o
: i Select » Tet
: of  Arrange All
5 Filters 3
3
- View >
S #, Zoom » |
[t =] Show Properties View O
Properties
N Drcnmcin Fommn Camband Cacli Al Chifs Naciim




Text

Additional functionality:

Text

Text

Text

Auto shapes arrange

Save whiteboard screen as a image file;

Text

true

false

Text

Text

Text
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STACKOVERFLOW API

E._ﬂ, Problems (E Console (’ Task Editor Mﬁ Stackoverﬂow] @ Review Edi‘tor] =8

Searchi  how to create java file [

Search ]
| Previous Qustian][ Mext Question ]

Question: Create a java file inside a package

Previous Answer H Mext Answer

»

You can get a special file inside the package by calling

java.net.URL imgURL = ResourceManager.class.getResource | "ResourceManager.class" );

m

From these URL vou can extract the directory, the file is placed.

A new file vou can create with

new File (directory,filename) ;

N
1| mn ]

E.; Problems (E Console (‘ Task Editor (I'j Stackoverflow quickview M_’ Review Edi‘tor] =0
Enter query: create java file Search

b, Ifipassthis fil Object to the Server can i create the same file there??

1 File fil=new File("D://Resume.doc"); H
v .
vy =

link | improve this question edited Apr 20 "11 at 9:40 asked Apr 20 11

?Eﬂl. Dennis
Mzl 837 =201

89% accef
feedback
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INSTALLATION

Following section concerns whole installation process, starting from downloading all required files,

ending on first-run configuration.

1. DOWNLOADING CP PLUGIN FROM SOURCEFORGE.NET

First, required CP plugin files can be downloaded from sourceforge.net project website:

Go to: https://sourceforge.net/projects/collabprogram/

Follow to section Files

Choose folder releases

oW o=

Download newest release

2. ADDING CP PLUGIN TO ECLIPSE

To install Collaborative Programming plugin, You need to move it to proper location on your hard-
drive.

Location to put FILENAME

Eclipse_folder \ plugins \

Where eclipse_folder stands for eclipse installation folder, default is:

C:\Program Files\eclipse

3. REQUIRED DEPENDENCIES

To run CP plugin properly, you need to install Graphical Modeling Project Runtime, which is
required by Whiteboard module.

GMP is hosted on www.eclipse.org/gmf/ , you can install it:

e by downloading Runtime package at the following location:
http://www.eclipse.org/modeling/gmp/downloads/?project=gmf-runtime

e using GMP update site: http://download.eclipse.org/modeling/gmp/updates/releases,

4. FIRST TIME RUN CONFIGURATION

At first run of plugin we must be sure to have some project in Eclipse Workspace. After installation
user must configure they account on XMPP server.

Step 1. Add Collaborative programming perspective to your Eclipse.

18
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5 (i) s (o)

[ Open Perspective l:' B [&a  CVS Repository Exploring
aJ lava

E‘J Java Browsing

E0 Team Synchronizing

XKML

Other...

-
= Open Perspective E@g

& Collaboration programming
% CV5 Repository Exploring
ﬁ Debug

[l,Git Repository Exploring

ﬁJJava

E,JJava Browsing

ngJava Type Hierarchy

':E}Planning

“I=Plug-in Development
|._|>_“| Resource (default)
EDTeam Synchronizing
XML

Step 2. Configure connection settings
On bottom side of Eclipse Window we have Contacts List View. If it your first attempt in using out

plugin then I suggest you use First Time Wizard in way to easy configure plugin:
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'l Y
& First Time Wizard ==

First Time Wizard

Welcome

Welcome!

This wizard will allow you fast begining with plugin.
On the next pages you need to provide necessery informations, without themn communication
and synchronization is not possible.

@ < Back Next » Finish

' Y
= First Time Wizard [

First Time Wizard

License agreement

Please read license agreement:

m»

GNU GENERAL PUBLIC LICENSE Version 2, June 1991 Copyright (C) 1989, [
1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA
02111-1307 USA Everyone is permitted to copy and distribute verbatim copies of
this license document, but changing it is not allowed. Preamble The licenses for most
software are designed to take away vour freedom to share and change it. Bv contrast,
the GINU General Public License is intended to guarantee your freedom to share and
change free software--to make sure the software is free for all its users. This General
Public License applies to most of the Free Software Foundation's software and to any
other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GINU Library General Public License instead.)}
Yo can annly it to vour nroorams foo When we snealke of free software we are

[V]1 accept license agreement

@ <Back || Net> || Finish
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& First Time Wizard — B

First Time Wizard

Ceonnection settings

(") Register new account

@ Use exsisting accout

Username:

Password:

Repeat password:

Server settings

@ [ <Back | Net> || Finsh ||  Cancel |

S et T e

First Time Wizard
€3 Both password must be exacly the same!

@ Register new account

() Use exsisting accout

Username: neEw_user

Password: sssssese

e sssssese
Server settings

@ <Back | Net> || Ensh || Cancel
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-
= First Time Wizard

First Time Wizard
You can finish Wizard

Testing connection settings selected in previcus step. If you encounter preblems please go back

and correct them.

Logs

Connecting to server
Connected to server
Legged in user
Successfully configured

@ . <Back || MNea> || Ensh || Canced |

B

-
= First Time Wizard

First Time Wizard

Connection configured sucessfully

Plugin is ready to use.

@ . <Back || Mee> || Ensh || Cancel |
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